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Electronic Plan Review (EPR) Procedure for Applicants 

Purpose  

This procedure facilitates the City and County of San Francisco’s (CCSF’s) electronic plan review process 

using Bluebeam Studio Projects and Sessions. This document will introduce the Applicant to the steps 

required to submit, view, coordinate and respond to CCSF’s EPR comments in Bluebeam Studio Sessions 

from the start of the project through submittal to the CCSF. 

Please note that if the Applicant chooses to use the optional EPR workflow for plan review, special software 

will be needed. Following this procedure requires: 1) Optical Character Recognition (OCR) function on 

scanned documents, and 2) Page Labeling function for the preparation of drawing documents. i.e. 

Bluebeam Revu or Bluebeam Revu eXtreme 20, 2019, 2018, or 2017. Screenshots and instructions 

typically use Bluebeam 2019. 
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Section A – Registration Process 

 Using this Procedure 

Note: This workflow is for customers comfortable using Bluebeam & Bluebeam Studio software. For 

customers that have no access to Bluebeam (Apple Macintosh users), an alternative workflow also 

exists for some procedure elements. Noteworthy workflow steps explained in this procedure include: 

creating a Bluebeam Studio Account, prepping PDF files for submittal/resubmittal using Bluebeam, 

submitting files, and Applicant response to CCSF review comments inside a Bluebeam Session. 

Prior to each submittal to CCSF, the Applicant must first format all PDF plans and documents following 

the steps outlined in this procedure.  

The Applicant will then submit formatted plans and documents electronically. The Electronic Plan 

Review (EPR) Support Staff generates a Bluebeam Studio Project specific to the Project’s Permit 

Application digital submission. The Bluebeam Studio Project serves as CCSF’s online storage location 

for all digital files related to the Permit Application. The EPR Support Staff will then perform a QAQC 

verification of the documents.  

Once the Applicant’s submittal files have been accepted, the EPR Support Staff creates a Bluebeam 

Studio Session for the City and County of San Francisco (CCSF) review. The Bluebeam Studio 

Review Session is an online location for digital plan review.  

Once the initial CCSF electronic review is complete, the Applicant will receive an email invitation to join 

the Bluebeam Studio Session to review and incorporate CCSF review comments. 

 Account Setup for Bluebeam Studio 

Note: For the Applicant to use EPR in Bluebeam, the Applicant must use Bluebeam Studio and create 

a Bluebeam Studio account. Bluebeam Studio is a cloud-enabled system that is built into Bluebeam, 

that allows CCSF to store files and perform simultaneous plan review of PDFs with the Applicant. 

Using Studio requires the creation of a Studio Account. Although the Studio Account will not be 

needed until review reconciliation, it should be the very first item completed within this procedure.  

Account setup does not require a paid version of Bluebeam. 

 Create a New Studio Account 

 Locate and click the “Studio” button  

 Within the Studio tab click the “Sign In” button  to sign in or to create a new 

Bluebeam Studio account 

Note: When creating an account for the first time, be sure to enter the Display Name in 

the following manner: 

First Last – Company  (ex: Mary Smith – XYZ Architects). If Applicant cannot list a 

company name, add the word “Applicant” instead (ex: Mary Smith – Applicant). 

 Set Required User Naming Conventions for Studio Account 

Note: Applicant name information shall abide by the following protocol: 

First Last – Company  (ex: Mary Smith – XYZ Architects). If Applicant cannot list a 

company name, add the word “Applicant” instead (ex: Mary Smith – Applicant). 
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 Once an Applicant has signed into Bluebeam, the user Display Name must be correctly 

entered in the following locations within the Preferences Dialog (found in the Revu pull-

down menu, or press Ctrl + K) 

 Bluebeam Preferences dialog: The “User” field, located in the “General” tab 

 

 Bluebeam Preferences dialog: The “Display Name” field, located in the “Studio” 

tab in the “Server” section 

 

 In a web browser, enter “studio.bluebeam.com” and log in with the Bluebeam Studio 

login username and password. 

 Select the “My Profile” tab on the left 

 Verify the name located in the “Default Name” box 

 Correct the name and click the “Update Profile” button 

 Log out and then back into Bluebeam Studio once all changes have been made 
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Section B – Document Submission Process 

 Prepare Drawing Documents for Submittals 

Note: All documents, including drawing documents, that require CCSF review and/or review comments 

must be PDF file type. Follow the steps outlined in this procedure to prepare applicable PDF files prior 

to submittal to CCSF. 

Many of the steps for preparing a PDF documents require a paid version of Bluebeam. 

 Resources for Best Practice PDF Creation from Authoring Software 

Note: Applicant is to ensure all best practices for PDF creation are used as applicable.  

 CCSF Exhibit F: General PDF Creation Guidelines. 

 PDF creation guidelines: found in the “Format your PDFs” section within the “How to 

create PDFs of your plans or addenda” page on the CCSF City (sf.gov) website: 

https://sf.gov/information/how-create-pdfs-your-plans-or-addenda 

 A note on Cross-Hatch fills: 

Avoid the use of dense crossed-line fills within drawings, as use of dense (i.e. less than 

1/8” apart on the plotted page) cross-line hatching can lead to rendering issues on 

PDFs. Dot patterns, earth patterns, and brick patterns are okay, as lines within those 

hatch patterns do not typically cross. Solid fill patterns are also generally okay if the 

solid pattern is not made from crossed lines. Use parallel lines instead. 

 A note on Digital Signatures: 

Do not add certificate-type digital signatures on submittal documents. Files submitted to 

CCSF must be unlocked/unrestricted to editing, and applying a digital signature restricts 

changes to the file. Use only scanned graphic-type signatures if required. 

 Document Naming Conventions for Document Submittals 

 Ensure all documents are named per Appendix 1 (found at the end of this document) 

and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately 

from this document). Naming instructions can also found in the “Name your PDFs” 

section of the “How to create PDFs” page on the CCSF City (sf.gov) website: 

 https://sf.gov/information/how-create-pdfs-your-plans-or-addenda 

 Sheet Count and Drawing Index  

Note: This aligns with CCSF procedures. Ensure set is coordinated prior to creating PDF of 

document. 

 In drafting software, list total sheet count on drawing sheet index page 

https://sf.gov/information/how-create-pdfs-your-plans-or-addenda
https://sf.gov/information/how-create-pdfs-your-plans-or-addenda
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 Verify sheet count on the sheet index matches total PDF document sheet count. 

 

 Blank Areas on Cover Page and in Title Block for Stamps 

Note: Each drawing page must have a space reserved for CCSF approval stamps as specified in the 

“How to create PDFs of your plans or addenda” section of the CCSF City (sf.gov) website. Areas 

stated here are just examples, to be superseded by direction of blank space areas on the CCSF City 

(sf.gov) website. See https://sf.gov/information/how-create-pdfs-your-plans-or-addenda for full 

instructions. Areas defined must be completely blank.  

 Provide a blank area within the title block. This reserved blank area must be in the same 

location for every page in the plan set. 

 Provide an additional blank area adjacent to the title block on the drawing set cover 

page (on the same page containing the Address, Description, and Index List) 

 

 

8-1/2”x11” 

Blank Area 

https://sf.gov/information/how-create-pdfs-your-plans-or-addenda
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 Document Size and Volumes 

 If file size exceeds 350MB, the document shall be broken up into volumes by discipline 

or consistent number of sheets. 

 Document Scale 

 PDF Drawings shall be plotted/printed at Full 1:1 Scale from authoring software. Do not 

“Scale to Fit” or reduce the PDF page size to be smaller than the original printed page 

size. 

 Scanned Document Prep 

Note: Scanned documents are slow to regenerate in Bluebeam – typically defined as taking 

more than 5 seconds per-page to regenerate. All scanned documents or pages that are slow to 

regenerate are required to go through this scanned document preparation section. It is not 

recommended that documents are scanned dots (raster) – ideally they should be “printed” lines 

(vector). See below. 

 

  
 Printed document     Scanned Document 

 Open the scanned PDF file 

 From the File Menu (located at the top of the Bluebeam screen), select “Export” 

 Click “JPEG” 
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 Browser window will open 

 Browse to save to a local folder (ideally a new folder). Note the folder location 

 Select “Save” 

 Convert JPG Image files Back to PDF 

 From the File menu, select “Create” 

 

 Click “From Multiple Files” 

 Browser window will open 

 

 Locate folder containing JPEGs saved from previous section 

 Select image files  

 Select Open 

 Stapler dialog will open 
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 Select “Advanced…” Button 

 

 Select 96 dpi from the resolution image drop down 

 Select OK 
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 Add a file name to the “One Output File”’ field 

 Select “Use source file folder” 

 

 Click OK 

 Run Optical Character Recognition (OCR) on Scanned PDF files 

Note: this OCR Section requires the Bluebeam eXtreme software version. It is optional 

for Applicants who do not have the eXtreme version of Bluebeam. 

 From the “Batch” pull-down menu, select “OCR”  
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 Confirm All Pages are selected 

 Set Document Type to CAD Drawings 

 Check “Detect Vertical Text” 

 Check “Detect text in pictures and drawings” 

 

 Uncheck all other options 

 Click OK 

 Create Page Labels in Thumbnails 

 From any page, zoom into the area containing the sheet’s page number and label 

 Go to Thumbnails icon 

 Click the Create Page Labels icon to the right of the Thumbnails drop-down 
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 Select Page Range > Select All Pages 

 Select Page Region > Click Select 

 

 Select Region of Page Label > Sheet Number  

Note: Draw a window around the Sheet Number as big as possible while staying inside 

the titleblock lines. Avoid selecting additional text besides the Sheet Number. Notice the 

window being sketched within the area highlighted with the red box. 

 

 

 Enter a space, a hyphen, and a space after [Region 1] 

 Click add to select a second region for the bookmark 

 

 Select Region of Page Label > Sheet Name 
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Note: Draw a window around the Sheet Title as big as possible while staying inside the 

titleblock lines. Avoid selecting additional text besides the Sheet Name. Notice the 

window being sketched within the area highlighted with the red box. 

 

 

 Review AutoMark Preview and Click OK. Page Labels will generate 

 

 Review in the Thumbnails tab to verify the sheet number and sheet name have been 

captured properly 

 

 If incorrect, double left-click and change incorrect title(s), or redo Page Labels 
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 Create Bookmarks 

Note: Bookmarks can be created directly from Page Labels. Verify all Page Labels are complete 

and correct before creating Bookmarks 

 Go to Bookmarks Tab  

 Click the “Create Bookmarks” icon  

 Select Page Labels and verify Page Range > Click OK 

 

 Page Label content will appear in the Bookmarks tab  

 Click the Bookmarks icon and select “Audit Bookmarks” from drop-down menu to 

confirm no broken bookmarks are found 

 

 Nesting Bookmarks 

Note: Before Nesting Bookmarks, verify all Bookmarks contain correct page label names 

matching the names in the Thumbnails (which match drawing sheet numbers & labels) 

 Go to ‘Bookmarks’ Tab 

 Select the first sheet in each section 



 
CCSF Permit Center  
O f f i c e  o f  t h e  C i t y  A d m i n i s t r a t i o n  

 

CCSF Electronic Plan Review Process  3/21/2022 
Applicant Procedure  Page 13 

 Right-click > Click “Add” > Select “Add Before…” 

 

 Name new bookmark by section - Example: ELECTRICAL 

 Select all “E” sheets and nest by pulling the documents over to the right under the 

ELECTRICAL bookmark 

 

 Repeat for all disciplines and other applicable documents (i.e.. specifications which 

contain bookmarked sections) 
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 Set Scale on Floor Plans 

Note: In addition to PDF plotting at Full 1:1 Scale, all Floor Plan Sheets should contain an appropriate 

measurement Scale that is stored in the PDF page. 

 Locate the Floor Plans 

 Verify a scale is listed in the title of the Floor Plan. Applicants must include a scale 

identification on all Floor Plans 

 

 Within the “Measurements” panel  locate the Page Scale section  

 

 Set Precision to 1/2 

 Manually enter the Scale to match the Scale of the Floor Plan, or select the scale from 

the “Preset” Scales (Bluebeam 2019) 

 
 

 
Bluebeam 2019 Bluebeam 2018 
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 Once the scale has been applied on a page, that scale is stored in the page. In 

Bluebeam 2018, the “Store Scale in Page” option is checked. In Bluebeam 2019, the 

page scale is listed within the Thumbnail. Check “Page Scale” in the Bluebeam 2019 

Label Options. 

 

 Repeat for all Floor Plans 

Note: Once a Scale is set on one page, it will become the default to set other pages in 

Bluebeam 2018 - by checking “Store Scale in Page”. In Bluebeam 2019, use the “Apply 

to Page Range” button to set multiple pages. 

 Remove Layers 

 Go to Layers Tab 

 Select layers listed 

Note: To select all quickly, select the top layer of the list, hold the shift key and select 

the bottom layer simultaneously. 
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 Right-click on highlighted layers and select Delete from the drop-down menu 

 

 Uncheck all options 

 

 Click Delete 

 Create Drawing Call-Out Hyperlinks 

Note: this Hyperlinks Section requires the Bluebeam eXtreme software version. It is optional for 

Applicants who do not have the eXtreme version of Bluebeam. 
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 Select “Add Open Files” uncheck any files that are not drawing files 

 

 Click Next 

 Select Settings 

 Select Filter Mode: “First from start” 

 From the Batch pull-down menu, select Link > New 
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 Select Filter Character. “’Space” 

 Click OK 

 

 Click Link Options 

 Check Include Appearance Properties 

 Select a light-yellow color 

 Set Style to Highlight 

 Click OK 
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 Select Page Label 

 Click “Generate” 

 Search Terms will generate  

 Click run to create hyperlinks 

 

 Once the hyperlinks are created, click “Finish and Close” 

 

 Flatten Document 

 From the “Document” pull-down menu, select “Flatten”  
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 In the “Flatten Markups” dialog, check “All Markups” 

 Verify ‘Allow Markup Recovery (Unflatten)’ is unchecked 

 

 Click Flatten 

 Save Documents 

 Prepare Additional Files for Submittals 

Note: Additional document such as Specifications, Calculations, and other supporting files must be 

prepared in addition to the drawings to allow for proper review by CCSF. Files requiring review and/or 

comments by CCSF must be PDF file type. Reference files may be other typical file types (Word, 

Excel, etc.) 

Preparation for non-drawings PDFs typically does not require a paid version of Bluebeam. 

 Specifications Prep 

 Specifications shall contain bookmarks identifying Specification Divisions 

 Specifications shall be free of Layers 

 Specifications shall be Flattened 

 Other Supporting Document Prep 

 All additional supporting documents shall be free of Layers 

 All additional supporting documents shall be Flattened 

 Add CCSF Applicant Back Check Page 

Note: Inserting the CCSF Applicant Back Check Page automatically adds the CCSF Custom Status 

Menu. The Status Menu applied to the document allows the Applicant to track the review & 

incorporation comments, and CCSF Reviewers to track OPEN and CLOSED comments.  
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IF THE CCSF APPLICANT BACK CHECK PAGE IS NOT PROPERLY ADDED, THE REVIEWER 

BACK CHECK CANNOT BE PERFORMED PROPERLY 

 Locate & Download the CCSF Applicant Back Check Page 

Note: The Back Check Page can be downloaded from the following location:  

https://sf.gov/add-our-back-check-page-your-plans 

 

 

 Insert Applicant Back Check Page 

Note: This step requires a licensed version of Bluebeam 

 In Bluebeam, open the submittal files (all documents where CCSF Reviewers may 

potentially add review comments) 

 Once all files are open, insert the Applicant Back Check Page as the last page in each 

document 

 From the “Document” pull-down menu, select “Insert > Pages from Document” 

 
Note: If the “Open Project File” dialog appears, click “Open from Disk”. If “Insert 

Pages” dialog opens, click the “Add” button 

https://sf.gov/add-our-back-check-page-your-plans
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 Browse to the locate the CCSF Bluebeam Back Check Menu Page and open 

the file 

 In the “Insert Pages” dialog, select “After” and check “Last Page” to insert the 

cover page at the end of the document

 
 Click OK 

 Verify the Page has been added at the end of the document 

 Repeat for all submitted files that require Session review or addition of the back check 

menu 

 Submit Documents to CCSF for Electronic Plan Review (EPR) 

Note: Section 6.0 defines the submission process to CCSF (DBI, Planning, etc.). For submissions to 

the Port of San Francisco, the applicant process uses Microsoft SharePoint. Applicants working on 

projects sited on Port Property will interface with SharePoint for both document submission and 

document retrieval throughout the permit process. Refer to the Port of SF website for instructions on 

how to submit documents to the Port Permit Desk for Electronic Plan Review: 

https://sfport.com/business/permit-services/electronicplanreview 

 Submitting files via the CCSF City website (sf.gov) 

Note: Once the Applicant has prepared and correctly formatted the PDF files, the Applicant will 

upload the files to the “Building Permits” section of the sf.gov website using the instructions 

found within the “Apply for a Building Permit” and “How to create PDFs of your plans or 

addenda” sf.gov webpages.  

 Ensure all documents are correctly formatted as defined within this procedure. 

Improperly formatted documents will be rejected by CCSF 

 Ensure the CCSF Applicant Back Check Page has been added as the last page of each 

submission document 

https://sfport.com/business/permit-services/electronicplanreview
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 Open a web browser, and enter the following web address: 

https://sf.gov/topics/building-permits 

 Choose the appropriate permit type and/or scroll to locate the “Resources” areas for 

Electronic Plan Review (EPR). 

Note: Some permits, such as Over the Counter (OTC) permits, are not available to 

submit online 

 Follow the instructions to verify Forms and Project Qualifications. The section contains 

additional instructions for document creation, and an “Apply Now” button to submit 

prepared documents 

 Submitting files directly into a Bluebeam Studio Session (as applicable) 

Note: In most cases, the Applicant will submit files via the CCSF City (sf.gov) website, not 

directly into Bluebeam Studio. 
 

In rare cases CCSF may determine that the Applicant will upload directly to the Bluebeam 

Session. The Applicant will receive, as part of their invitation & link to the Studio Session, 

instructions to “resubmit the entire set of drawing plans by uploading the revised set to the 

Session”. The Applicant should only attempt to submit directly to the Session if they receive 

these specific instructions. 
 

Uploading files directly to a Bluebeam Studio Session requires a paid version of Bluebeam. 
 

Access to a Bluebeam Studio Session requires a Bluebeam Studio Account. Refer to the 

“Account Setup for Bluebeam Studio” section located within this Procedure for instructions on 

setting up a Studio account and required display name conventions for Studio accounts. The 

Account and display name must be set prior to submitting. 
 

In addition to a link, the Bluebeam Studio Session can also be joined using a (Bluebeam 

Studio Project) Studio ID, which will be included in the invite email. The Studio ID is a random 

nine-digit code provided by CCSF. It is unrelated to the Application number or project address, 

etc. 

 Ensure all documents are named and formatted as defined within this procedure. 

Improperly formatted documents will be rejected by CCSF 

 Ensure the CCSF Applicant Back Check Page has been added as the last page of each 

submission document 

 Open Bluebeam Software 

 Verify connection to Bluebeam Studio  (i.e. the icon is “plugged in”) 

 Open the Bluebeam Studio Session 

 Refer to the sections titled “Joining the Bluebeam Studio Session via Email 

Link” and/or “Joining a Bluebeam Studio Session via Session ID” located in the 

“Incorporate CCSF Review Comments” Section of this document (Section 9.0) 

https://sf.gov/topics/building-permits
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 Once the Session is opened, locate the “Documents” area in the Session tab 

 Click the “Add File” button  within the “Documents” area 

  
Note: If the “Add File” button is missing, it indicates the “Add Documents” Session 

permission has not been granted to the email address used by the Applicant to sign into 

Bluebeam Studio. Verify with the CCSF EPR Support Staff that the email address used 

by the Applicant to access the Studio Session has the “Add Documents” Session 

permission. 

 Browser window will open 

 Select the PDF file (Hold Ctrl or Shift to select Multiple files) 

 Select Open to add the files 

 Notify CCSF DBI Reviewer and EPR Support Staff 

 Once all submittal files have been successfully added to the Studio Session, 

notify the DBI Plan Reviewer, as well as any applicable CCSF EPR Support 

Staff of Bluebeam Session submittal via email. Do not use Bluebeam Alerts 

to notify Reviewers or other CCSF Staff. 

 Submitting files directly into a Bluebeam Studio Project (as applicable) 

Note: In most cases, the Applicant will submit files via the CCSF City (sf.gov) website, not 

directly into Bluebeam Studio. 
 

In rare cases CCSF may determine that the Applicant will upload directly to the Bluebeam 

Project. The Applicant will receive an invitation to submit to the Studio Project and a link to the 

Studio Project via email. This invitation will be separate from the invitation to join the Studio 

Session. 
 

Uploading files directly to a Bluebeam Studio Project requires a paid version of Bluebeam. 
 

Access to a Bluebeam Studio Project requires a Bluebeam Studio Account. Refer to the 

“Account Setup for Bluebeam Studio” section located within this Procedure for instructions on 

setting up a Studio account and required display name conventions for Studio accounts. The 

Account and display name must be set prior to submitting. 
 

A Bluebeam Studio Project can also be joined using a (Bluebeam Studio Project) Studio ID, 

which will be included in the invite email. The Bluebeam Studio Project ID is a random nine-digit 

code provided by CCSF. It is unrelated to the Application number or project address, etc. 
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 Ensure all documents are named and formatted as defined within this procedure. 

Improperly formatted documents will be rejected by CCSF 

 Ensure the CCSF Applicant Back Check Page has been added as the last page of each 

submission document 

 Open Bluebeam Software 

 Verify connection to Bluebeam Studio  (i.e. the icon is “plugged in”) 

 Open the Bluebeam Studio Project by clicking the link included in the email invitation 

(provided by CCSF). As long as the Applicant is connected to Bluebeam Studio , the 

link will open the Studio Project tab automatically.  

 If a link is not available or not working, the Applicant may also open the Studio Project 

manually if they have been invited and have the Studio Project ID 

Note: The Bluebeam Studio Project ID is a random nine-digit code provided by CCSF. It 

is unrelated to the Application number or project address, etc. 

 Click the Studio Projects button  

 Under Studio drop-down menu select + . The “Join” dialog box appears. 

 

 Enter the nine-digit Bluebeam Studio Project ID 

 Click OK. The Bluebeam Project tab will open 

 Once the Studio Project tab is open, locate the CCSF EPR folders. In the PERMIT 

SUBMITTAL folder, locate the sub folder titled 3. DOCUMENTS FOR REVIEW 
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 Right click on folder 

 Select Upload Files Icon 

 

 Browser window will open 

 Select the file to upload (Hold Ctrl or Shift to select Multiple files) 

 Select Open to upload the files 

 Notify CCSF of Submittal 

 Once all submittal files have been successfully uploaded to Studio Project, 

notify CCSF EPR Support Staff of Bluebeam Project submittal via email. Do 

not use Bluebeam Alerts to notify Reviewers or other CCSF Staff. 

 Intake of Applicant Submittal Files 

Note: Once CCSF EPR Support Staff receives the Applicant submission, the EPR Support Staff will 

perform a QAQC review of the submitted files. If document preparation is incomplete and/or not in 

compliance with this procedure, EPR Support Staff will notify the Applicant and request an updated 

resubmittal to CCSF. 
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Section C – Plan Review Process 

 Initial Electronic Plan Review Process  

Note: Once the initial review documents have been uploaded by the Applicant and have received 

approval from CCSF EPR Support Staff, a notification will be sent out to CCSF Reviewers to begin the 

plan review process. Review time starts when the documents are found to be satisfactory. 

Departments reviewing include Planning, DBI (Department of Building Inspection), PUC (Public 

Utilities Commission), PW (Public Works), DPH (Department of Public Health) and MOD (Mayor's 

Office of Disability). Reviews may be performed sequentially or simultaneously.  
 

Once the initial review phase is completed, the applicant will be invited into a Bluebeam Session to 

incorporate comments. Applicants will respond, using the custom Status Menu, prior to resubmitting 

revised documents. Once changes have been addressed by the Applicant, the Applicant will create 

and upload subsequent submittal documents. Do not upload subsequent submittals until all CCSF 

Reviewer stations/departments have completed their reviews.  

Applicants that have no access to a free version of Bluebeam Revu (Apple Macintosh users) can work 

directly with the CCSF DBI Reviewer and/or CCSF Support staff to receive PDF drawings via the SF 

SecureShare file sharing service. Reference EPR Exhibits K1 and K2 when contacting CCSF for 

additional information regarding using this service. 

 Incorporate CCSF Review Comments 

Note: Once the CCSF initial document review has been completed, Applicant will be invited via email 

into a Bluebeam Review Session to incorporate comments. Incorporating comments is a joint process 

between the CCSF review team and the Applicant. 

Incorporation response to Reviewer comments does not require a paid version of Bluebeam 

Access to a Bluebeam Studio Session requires a Bluebeam Studio Account. Before joining the 

Session, refer to the “Account Setup for Bluebeam Studio” section located within this Procedure for 

instructions on setting up a Studio account and required name conventions for Studio accounts. 

 Joining the Bluebeam Studio Session via Email Link 

 Open Bluebeam Software 

 Ensure Bluebeam Studio is Connected (icon is “plugged in”) 

 

 Locate the Bluebeam Studio Session invitation email 

 Click the link within the invitation to connect to the Bluebeam Studio Session 
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 Joining a Bluebeam Studio Session via Session ID 

 Locate the Bluebeam Studio Session invitation email containing the nine-digit Bluebeam 

Session ID (ex. 111-222-333) 

 Open Bluebeam Software 

 Connect to Bluebeam Studio and click the Session button  

 Ensure Bluebeam Studio is Connected (icon is “plugged in”)  

 Within the Studio tab, locate and click the ‘plus’ button + . The “Join” dialog box appears 

 

 Enter the nine-digit Bluebeam Session ID and click “OK” 

 Navigating Documents & Review Comments 

Note: For Bluebeam Studio Session layout, refer to Exhibit E: Bluebeam Studio Session Layout 

 Right-click on Session document. Select Open 

 

 Open the Markups List Panel 

Note: the Markups List panel is typically located on the bottom of the Bluebeam 

software. In the “Window” pull-down menu, select “Panels >  Markups” or press 

ALT+L to show the Markups list if it is hidden. 
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 Locate Reviewers’ markup comments in the Markups List 

Note: The Markups List automatically tracks information for each Reviewer markup 

placed on a PDF, including Date, Page Label, Author, Color, Comments and Status. By 

default, it is found in the bottom panel.  

 

 Filtering Comments 

Note: The Filter feature within the Markups List allows a user to temporarily remove markup 

comments – “filtering”, or removing those comments based upon specific parameters. One can 

filter to only show a specific Author of comments, a specific page of comments, etc. 

 On the Markups list toolbar, click the Filter icon  

  

 A filter icon then appears next to each column heading in the Markups list 

 

 Click the filter icon   associated with the desired column and select the value to filter 

 Repeat as desired to filter by other values. 

Note: While filters are active, the markups list shows only those markups that match the 

selected filters. All other markups are hidden.  

 Applicant Response to CCSF Reviewers’ Comments – Incorporating Comments 

Note: Applicants must respond to each and every comment to indicate a reconciliation action or 

inaction to the reviewer.  
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To notify the reviewer that the markup comment will be integrated into a revised document 

submission, the Applicant will set the Status of the comment to “Incorporated”. There are two 

ways to do this: Right-clicking on the comment, or double-clicking in the status column of the 

comment.  
 

Once the Applicant has updated/revised the drawings and other documents per the review 

comments (prior to the subsequent submittal), the Applicant will use the Markups List “Status” 

column to indicate to CCSF that the Reviewers’ comment has been incorporated 

 Incorporate Comments by Right-Clicking 

 Locate the Reviewer’s comment (either on the page or in the Markups List) 

 

 Right-click on the comment and select the Set Status 

 

 From CCSF Back Check Status menu titled “*****Applicant’s response prior to 

revised submittal*****” select “INCORPORATED (per reply as needed)” 
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 Repeat until all comments have been incorporated completely 

 

 Incorporate Comments using the Status Column  

 Double-click on the comment inside of the status column and select 

“INCORPORATED (per reply as needed)” from “*****Applicant’s response prior 

to revised submittal*****”. 

 

 Add an additional “Reply” to comments 

 To add a comment/note related to a markup response, Right-click on the comment 

(either on the page or in the Markups List) and select “Reply” from drop-down menu. 

Type a response in the open text box stating how the comment has been addressed. 

Clearly indicate the location and changes to be provided. 

 Applicant Response to CCSF Reviewers’ Comments – Not Incorporating Comments 

Note: Applicants must respond (using the “Reply” function) to each comment to indicate a 

reconciliation action or inaction to the reviewer.  
 

To notify the reviewer that the markup comment will NOT be integrated into a revised document 

submission, the Applicant will set the Status of the comment to “Not Incorporated”. There are 

two ways to do this: Right-clicking on the comment or double-clicking in the status column of the 
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comment. The Applicant must also add a response using the “Reply” function for each 

unincorporated comment, to explain the reason for non-compliance / not integrating the 

reviewer’s comment into the revised submission.  

 Locate the Reviewer’s comment 

 Double-click on the comment inside of the status column, and select “NOT 

INCORPORATED (per reply)” from CCSF Back Check Status menu titled  

“*****Applicant’s response prior to revised submittal*****” 

 Right-click on the comment and select Set Status > “NOT INCORPORATED (per reply)” 

from CCSF Back Check Status menu titled “*****Applicant’s response prior to revised 

submittal*****” 

 

 

 Add the required “Reply” comment to the response by right-clicking on the comment and 

selecting “Reply” from the drop-down menu.  

 Type a response in the text box stating the reason that the comment was not 

addressed. Clearly indicate the reasoning and explanation for non-compliance.
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 Notify CCSF of Completed Comment Response 

 Once Applicant comment response is completed within the Studio Session, notify the 

DBI Plan Reviewer, as well as any applicable CCSF EPR Support Staff, via email. Do 

not use Bluebeam Alerts to notify Reviewers or other CCSF Staff. 

 Subsequent Submittals  

Note: Subsequent plan check submittals shall be submitted as entire sets of drawing plans – 

responding to corrections requested in the prior review. The Applicant shall resubmit the entire 

drawing set, even if markup comments/changes only appear on a few of the individual pages. 

Once changes have been addressed by the Applicant, the Applicant will create and upload 

subsequent submittals to the CCSF City Website or to Bluebeam Studio as directed by CCSF. After 

EPR Support Staff have completed the intake review and found it to be satisfactory, EPR Support Staff 

will send out a notification to the reviewers to begin the Subsequent Submittal review. 

 Submit Subsequent Files via the CCSF City Website (sf.gov) 

 Ensure all documents are named per Appendix 1 (found at the end of this document) 

and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately 

from this document). Naming instructions can also found in the “Name your PDFs” 

section of the “How to create PDFs” page on the CCSF City (sf.gov) website: 

 https://sf.gov/information/how-create-pdfs-your-plans-or-addenda 

 Ensure all documents are correctly formatted as defined within this procedure. 

Improperly formatted documents will be rejected by CCSF. 

 Open a web browser, and enter the following web address: 

https://sf.gov/topics/building-permits 

 Choose the appropriate permit, and/or scroll to the Electronic Plan Review Resources 

section. Follow the instructions to verify Forms and Project Qualifications. The section 

contains additional instructions for revised documents, and a “Submit” button to submit 

the prepared documents 

 Submit Subsequent Files Directly to a Studio Session or Project (if directed by CCSF) 

Note: Refer to Section titled “Submit Documents to CCSF for EPR” for additional instructions  

 Ensure all documents are named per Appendix 1 (found at the end of this document) 

and/or Exhibit B: Document Naming Table for Applicant Submissions (found separately 

from this document). Naming instructions can also found in the “Name your PDFs” 

section of the “How to create PDFs” page on the CCSF City (sf.gov) website: 

 https://sf.gov/information/how-create-pdfs-your-plans-or-addenda 

 Ensure all documents are correctly formatted as defined within this procedure. 

Improperly formatted documents will be rejected by CCSF. 

 Ensure that the CCSF Applicant Back Check Page has been added at the end of all 

submittal documents  

 Open Bluebeam Software and ensure Bluebeam Studio is connected.  

 If submitting directly into a Studio Session 

 Join the Bluebeam Session. Refer to previous sections titled “Joining the 

Bluebeam Studio Session via Email Link” and/or “Joining a Bluebeam Studio 

Session via Session ID” for instructions 

https://sf.gov/information/how-create-pdfs-your-plans-or-addenda
https://sf.gov/topics/building-permits
https://sf.gov/information/how-create-pdfs-your-plans-or-addenda


 
CCSF Permit Center  
O f f i c e  o f  t h e  C i t y  A d m i n i s t r a t i o n  

 

CCSF Electronic Plan Review Process  3/21/2022 
Applicant Procedure  Page 34 

 Add the PDFs using the “Add File” button . Refer to the previous 

“Submitting files directly into a Bluebeam Studio Session” Section of these 

Procedures for instructions. 

 If Submitting directly into a Studio Project 

 Join the Bluebeam Project 

 Upload the documents into the DOCUMENTS FOR REVIEW folder 

Note: Refer to the previous “Submitting files directly into a Bluebeam Studio 

Project” Section of these Procedures for instructions on both joining the Studio 

Project and Uploading documents. 

 Once the files are submitted, notify CCSF EPR Support Staff of Subsequent Submittal 

via email. Do not use Bluebeam Alerts to notify Reviewers or other CCSF Staff. 

 Intake of Applicant Subsequent Submittal files 

Note: Once Applicant files have been submitted to CCSF, the CCSF EPR Support Staff will 

perform a QAQC review of the submitted files. If document preparation is incomplete, EPR 

Support Staff will notify the Applicant and request an updated resubmittal to CCSF. 
 

When EPR Support Staff have completed the intake and QAQC review and found the submitted 

files to be satisfactory, they will send out a notification to the CCSF reviewers to resume the 

Subsequent Electronic Plan Review. 

 Subsequent Electronic Plan Review Process  

Note: Once the Subsequent review documents have been uploaded and passed intake from the 

CCSF EPR Support Staff, CCSF Reviewers will resume the plan review process.  
 

After the Subsequent review phase has been completed, the applicant will be notified to rejoin 

the Electronic Plan Review session to incorporate subsequent comments. The subsequent 

electronic plan review session will almost always be the same session as the initial review 

session. Refer to the “Joining the Bluebeam Studio Session” Section of these Procedures. 
 

Applicants will respond to reviewer’s comments using the custom Status menus in the Bluebeam 

Markups List prior to resubmitting revised documents.  

 Create a Markup Alert to track Reviewer progress 

Note: It is the Applicants’ responsibility to remain “active” during the subsequent review 

process, as the Reviewers will not notify Applicants when subsequent comments are 

made. Applicants may want to create Mark-up Alerts in Bluebeam to better track the 

progress of Reviewers. 
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 From the Session list (before entering the Session), right-click the Session 

name and select “Manage Notifications” 

 

 A WebTab titled Studio Notifications Preferences will open in Bluebeam 

 In the Account Preferences section, check the box to “Send me an email with 

Markup Alerts for all Sessions” 

 

 Click “Apply” and close the WebTab 

 

Once changes have been addressed by the Applicant, the Applicant will create and upload 

additional subsequent submittals as required, until all submittal documents comply with CCSF 

requirements. 

 Stamp-Out and Approval 

Note: Each departments’ EPR Reviewer will apply an approval stamp to the document(s) once their 

respective review is completed. Once all departments have reviewed and approved the documents, 

the EPR Support Staff will be notified that the electronic plan review is complete, and the project is 

approved. EPR Support Staff will then notify Permit Services that the documents are ready for final 

issuance of permit. Once that process is completed, the Applicant will be notified of “Final Approval” of 

the project by CCSF Permit Services. The Applicant will also receive a link to download the approved 

files.  
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Note:  All documents submitted to CCSF DBI / Planning must follow naming guidelines. The 

descriptions and tables below identify the most common submissions.  

 CCSF Document Naming Components and Naming Structure 

 File Name Examples 

• 001-FORM 3-8 202201014784.pdf 

• 101-SITE DWGS-REV0 202201014784.pdf 

• 202-BLDG SPEC-REV1-202201014784.pdf 

• 303-BLDG CALCS-REV2 202201014784_ADD2 MEP.pdf 

• 401-SITE REPORT Lighting-REV0 202201014784.pdf 

• 501-LETTER PW to DBI-REV0 202201014784.pdf 

[Number Prefix]-[Document type]-[Revision Number] [Application Number]_[Type / Count of Addenda] 

Example of CCSF Session Documents: 

 

 File Name Component Summary 

 CCSF Submission File Names will always contain four to five parts: 

• Number Prefix. The Number prefix serves two functions: to identify the type of 

document (101 for Drawings, 201 for Specifications, etc.), and to provide an order for 
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the type of document (201 = First Specification Doc; 202 = Second or Revised 

Specification Doc). 

• Document type. Typically one of the six standard document types: Forms, Drawings, 

Specifications, Calculations, Reports and Letters 

• A Revision number. The Initial Submission is considered “REV0”. Subsequent Revised 

Submissions contain REV1, REV2, REV3, etc. 

• Application number. If no Application number exists, substitute the street address of 

the project. 

• Type of Addenda & Count of Addenda. If applicable. 

 File Name Component Order 

 File name components will be in the following order: 

• [Number Prefix]-[Document type]-[Revision Number] [Application Number]_[Type / 

Count of Addenda] 

If no Application number exists yet, substitute the street address of the project: 

• [Number Prefix]-[Document type]-[Revision Number] [Street address]_[Type / Count of 

Addenda] 

 Document Type Naming Conventions and Prefix Numbers 

 CCSF accepts six document types. Each type has a prefix identifier: 

• Forms (FORMS) – 001, 002, 003, etc 

• Drawings (DWGS) – 101, 102, 103, etc. 

• Specifications (SPECS) – 201, 202, 203, etc. 

• Calculations (CALCS) – 301, 302, 303, etc. 

• Reports (REPORTS) – 401, 402, 403, etc. 

• Letters (LETTERS) – 501, 502, 503, etc. 

 Permit-Type Naming Conventions 

Note: For each document type, the Applicant must specify if they are for Site permits or Building 

permits in the file name. 

 Site Permit Name Examples: 

• Drawings: SITE DWGS 

• Calculations: SITE CALCS  

• Reports: SITE REPORTS 

 Building Permit Name Examples: 

• Drawings: BLDG DWGS 

• Calculations: BLDG CALCS  

• Reports: BLDG REPORTS 

 Addenda Naming Conventions 

 Addenda must contain “BLDG ADD_[X]” as well as the addenda type included. CCSF 

accepts the following types of addenda: 

• Grading 
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• Foundation 

• Superstructure 

• Architecture 

• Mechanical, electrical and plumbing (MEP) 

• Final 

 Revision Number Naming Conventions 

 Include a revision number as “-REV[X]” with the X being the revision number (REV1, 

REV2, etc.). Submittal first drafts include a “REV0” number. 

 Document Naming Table for CCSF DBI / Planning Submissions 

 Document Submissions for Planning or OCII – Initial Submissions 

 

 Document Submissions for Planning or OCII – Subsequent Submissions 

 

 Document Submissions for Building – Initial Submissions 

First 
Component 

Second 
Component 

Third 
Component 

Fourth Component 
Fifth Component 
(as Applicable) 

File 
Type 

001 -SITE FORMS 
-REV0 (as 
applicable) 

APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

101 -SITE DWGS -REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

201 -SITE SPECS -REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

301 -SITE CALCS -REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

401 
-SITE 

REPORTS 
-REV0 APPLICATION NUMBER, if applicable. If not 

applicable, use ADDRESS or PROPERTY NAME 
_ADD[X] .pdf 

501 
-SITE 

LETTERS 
-REV0 APPLICATION NUMBER, if applicable. If not 

applicable, use ADDRESS or PROPERTY NAME 
_ADD[X] .pdf 

First 
Component 

Second 
Component 

Third 
Component 

Fourth Component 
Fifth Component 
(as Applicable) 

File 
Type 

002, 003… -SITE FORMS 
-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

102, 103… -SITE DWGS 
-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

202, 203… -SITE SPECS 
-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

302, 303… -SITE CALCS 
-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

402, 403… 
-SITE 

REPORTS 

-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

502, 503… 
-SITE 

LETTERS 

-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

First 
Component 

Second 
Component 

Third 
Component 

Fourth Component 
Fifth Component 
(as Applicable) 

File 
Type 

001 
-BLDG 

FORMS 

- REV0 (as 
applicable) 

APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 
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 Document Submissions for Building – Subsequent Submissions 

 Document Submissions for Building – Addendum Document Submissions 

 

 

101 -BLDG DWGS -REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

201 
-BLDG 
SPECS 

-REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

301 
-BLDG 
CALCS 

-REV0 APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] .pdf 

401 
-BLDG 

REPORTS 
-REV0 APPLICATION NUMBER, if applicable. If not 

applicable, use ADDRESS or PROPERTY NAME 
_ADD[X] .pdf 

501 
-BLDG 

LETTERS 
-REV0 APPLICATION NUMBER, if applicable. If not 

applicable, use ADDRESS or PROPERTY NAME 
_ADD[X] .pdf 

First 
Component 

Second 
Component 

Third 
Component 

Fourth Component 
Fifth Component 
(as Applicable) 

File 
Type 

002, 003… 
-BLDG 

FORMS 

-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

102, 103… -BLDG DWGS 
-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

202, 203… 
-BLDG 
SPECS 

-REV1, 
REV2... 

APPLICATION NUMBER _ADD[X] .pdf 

302, 303… 
-BLDG 
CALCS 

-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

402, 403… 
-BLDG 

REPORTS 

-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

502, 503… 
-BLDG 

LETTERS 

-REV1, 
REV2... APPLICATION NUMBER _ADD[X] .pdf 

  
 

   

First 
Component 

Second 
Component 

Third 
Component 

Fourth Component 
Fifth Component 
(as Applicable) 

File 
Type 

001, 002… 
-BLDG 

FORMS 

-REV[X] (as 
applicable) 

APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] Grading .pdf 

101, 102… -BLDG DWGS 
-REV[X] APPLICATION NUMBER, if applicable. If not 

applicable, use ADDRESS or PROPERTY NAME 
_ADD[X] 

Foundation 
.pdf 

201, 202… 
-BLDG 
SPECS 

-REV[X] APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

_ADD[X] 
Superstructure 

.pdf 

301, 302… 
-BLDG 
CALCS 

-REV[X] APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

ADD[X] 
Architecture 

.pdf 

401, 402… 
-BLDG 

REPORTS 

-REV[X] APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

ADD[X]  
MEP 

.pdf 

501, 502… 
-BLDG 

LETTERS 

-REV[X] APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 

ADD[X]  
Final 

.pdf 
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Note: All documents submitted to Port must follow the below naming guidelines. Please note the Port 

uses different naming conventions for permit submittals than the San Francisco Department of 

Building Inspection. The descriptions and tables below identify the most common submissions. 

 Port of SF Document Naming Components and Naming Structure 

 File Name Examples 

• B-2022_0001_BLDG DWGS-REV0.pdf 

• B-2022-0001_BLDG CALCS-REV1.pdf 

• B-2022-0001_BLDG ADD_1 Architecture_DWGS-REV1.pdf 

• B-2022-0001_BLDG ADD_2 MEP_CALCS-REV1.pdf 

 File Name Component Summary 

 Port Submission File Names will always contain five parts: 

• Permit Type. Building Permit or Encroachment  

• Year. The year drawings associated with the permit were first accepted for review by 

the Port Permit Desk. 

• Unique 4-Digit Number. Provided by the Port Permit Desk. Note unlike DBI (which 

nests addenda submittals under a project’s permit number) the Port issues a new 

unique 4-digit permit number for each addendum issued. 

• Document Type. The Port accepts three document types: Drawings, Calculations, and 

Reports 

• A Revision Number. Include a “REV0” in all files of the Initial Submission. Subsequent 

Revisions will be numbered “REV1”, “REV2”, etc. 

 File Name Component Order 

 File name components will be in the following order: 

• [Permit Type]_[Year]_ [4-Digit Number]_[Document type]-[Revision Number] 

 If no Application number exists, substitute the street address of the project: 

• [Permit Type]_[Year]_ [Street Address]_[Document Type]-[Revision Number] 

 Permit Type Naming Conventions 

 The Port accepts 2 Permit types: 

• Building Permits (B) 

• Encroachment Permit (E) 

 Document Type Naming Conventions 

 The Port accepts six document types.  

• Forms (FORMS)  

• Drawings (DWGS)  

• Specifications (SPECS)  

• Calculations (CALCS)  
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• Reports (REPORTS) 

 Permit Type Naming Conventions 

Note: For each document type, the Applicant must specify if they are for or Building Permits or 

Encroachment Permits in the file name. (Note: the Port treats site permits as Building Permits) 

 Building Permit Name Examples: 

• Drawings: BLDG DWGS 

• Calculations: BLDG CALCS  

• Reports: BLDG REPORTS 

 Encroachment Permit Name Examples: 

• Drawings: ENCR DWGS 

• Calculations: ENCR CALCS  

• Reports: ENCR REPORTS 

 Addenda Naming Conventions 

 Addenda must contain “BLDG ADD_[X]” as well as the addenda type included. CCSF 

and the Port accept the following types of addenda: 

• Grading 

• Foundation 

• Superstructure 

• Architecture 

• Mechanical, electrical and plumbing (MEP) 

• Final 

 Revision Number Naming Conventions 

 Include a revision number as “-REV[X]” with the X being the revision number (REV1, 

REV2, etc.). Submittal first drafts include a “REV0” number. 

 Document Naming Table for Port of SF Submissions 

 Documents for the Port of SF 

First 
Component 

Second 
Component  Third Component 

 Fourth  
Component 

Fifth  
Component* 

File 
Type 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG 
FORMS 

-REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG DWGS -REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG 
SPECS 

-REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG 
CALCS 

-REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG 
REPORTS 

-REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if applicable. If not 
applicable, use ADDRESS or PROPERTY NAME 
 

-BLDG 
LETTERS 

-REV[X] .pdf 
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 Addendum Documents for Port of SF 

 

 

 

First 
Component 

Second 
Component 

Third Component 
Fourth  

Component 
Fifth Component 

Sixth 
Component* 

File 
Type 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X] 
Grading 

_BLDG DWGS, 
CALCS,REPORTS 

-REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X] 

Foundation 

_BLDG DWGS, 
CALCS,REPORTS -REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X] 

Superstructure 

_BLDG DWGS, 
CALCS,REPORTS -REV[X] .pdf 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X] 

Architecture 

_BLDG DWGS, 
CALCS,REPORTS 

-REV[X] 
.pdf 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X]  

MEP 

_BLDG DWGS, 
CALCS,REPORTS 

-REV[X] 
.pdf 

Permit Type Year APPLICATION NUMBER, if 
applicable. If not applicable, use 
ADDRESS or PROPERTY NAME 

_BLDG 
ADD_[X]  

Final 

_BLDG DWGS, 
CALCS,REPORTS 

-REV[X] 
.pdf 
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Applicants who choose to use Bluebeam in order to partake in the Electronic Plan Review process 

should understand that some components of that process use a paid (licensed) version of Bluebeam, 

and some components use a free (unlicensed) version of Bluebeam.  

Breaking down the EPR workflow described in these Procedures into the three main components: 

formatting PDFs, submitting/resubmitting files, and responding to Reviewers’ comments, it is important 

to note which components use free or paid software: 

• Formatting PDF Documents for submittal / resubmittal - Bluebeam Revu Standard or 

Bluebeam Revu eXtreme (see table below) 

• Submitting / resubmitting documents via sf.gov website – Bluebeam not required.  

• Submitting / resubmitting documents via Studio Session or Studio Project – Any licensed 

(paid) version of Bluebeam Revu 

• Joining the Bluebeam Session and responding to Reviewers’ comments – any licensed (paid) 

or unlicensed (free) version of Bluebeam Revu 

Applicants or Applicant Subcontractors wishing to review and respond to in-Session CCSF Review 

comments can do so using a free (unlicensed) version of Bluebeam. The free (unlicensed) version of 

Bluebeam is simply an installed trial version where the trail has expired. Note that this functionality will 

only be available when working on Session documents while inside a Bluebeam Session. 

 Identification of Paid (Licensed) or Free (Unlicensed) Versions 

Note: The table below defines the need for a paid/free version of Bluebeam Revu. Items defined below 

are specific to Procedure Items from this EPR Applicant Procedure. 

Procedure Item Free or Paid / 
Bluebeam Version 

Notes 

 

 Account Setup for Bluebeam Studio 

 Create a New Studio Account Free / Any Version  

 Set Required User Naming Conventions for Studio Account Free / Any Version  

 Prepare Drawing Documents for Submittals 

 Resources for Best Practice PDF Creation Not Applicable  

 Document Naming Conventions for Document Submittals Not Applicable  

 Sheet Count and Drawing Index Not Applicable  

 Blank Areas on Cover Page and in Title Block for Stamps Not Applicable  

 Document Size and Volumes Not Applicable  

 Document Scale Paid / Any Version  

 Scanned Document Prep Paid / Any Version  

 Convert JPG Image files Back to PDF Paid / Any Version  

 Run Optical Character Recognition on Scanned PDF files Paid / eXtreme only Step 3.9 is optional 

 Create Page Labels in Thumbnails Paid / Any Version  

 Create Bookmarks Paid / Any Version  

 Nesting Bookmarks Paid / Any Version  

 Set Scale on Floor Plans Paid / Any Version  

 Remove Layers Paid / Any Version  

 Create Drawing Call-Out Hyperlinks Paid / eXtreme only Step 3.15 is optional 

 Flatten Document Paid / Any Version  

 Prepare Additional Files for Submittals 

 Specifications Prep Paid / Any Version  

 Other Supporting Document Prep Paid / Any Version  

 Submit Documents to CCSF for Electronic Plan Review  
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 Submitting files via the CCSF City website (sf.gov) Not Applicable  

 Submitting files directly into a Bluebeam Studio Session Paid / Any Version  

 Submitting files directly into a Bluebeam Studio Project Paid / Any Version  

 Intake of Applicant Submittal Files 

 Initial Electronic Plan Review Process 

 Incorporate CCSF Review Comments 

 Joining the Bluebeam Studio Session via Email Link Free / Any Version  

 Joining a Bluebeam Studio Session via Session ID Free / Any Version  

 Navigating Documents & Review Comments Free / Any Version In Session only 

 Filtering Comments Free / Any Version In Session only 

 Applicant Response – Incorporating Comments Free / Any Version In Session only 

 Add an additional “Reply” to comments Free / Any Version In Session only 

 Applicant Response – Not Incorporating Comments Free / Any Version In Session only 

 Subsequent Submittals 

 Submit Subsequent Files via the CCSF City Website (sf.gov) Not Applicable  

 Submit Subsequent Files Directly to a Session or Project Paid / Any Version  

 Intake of Applicant Subsequent Submittal files Not Applicable  

 Subsequent Electronic Plan Review Process Free / Any Version In Session only 

 Stamp-Out and Approval 
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